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Installation & Upgrade 
 

This Installation & Getting Started User’s Guide provides basic 
information about installing and setting up RI District Administration 
Software (RI-DAS).  

Knowledge Base 

The information that you require for learning and using RI District 
Administration Software (RI-DAS) can be found in an extensive 
Knowledge Base that is installed at the same time as the program.  
The Knowledge Base provides a detailed explanation of the software, 
step-by-step instructions and examples.  The Knowledge Base can be 
used as an online manual or sections can be printed to your computer 
printer if you require printed notes. 

 

The Knowledge Base can be opened from the Help menu or from the 
Knowledge Base icon found with the other RI District 
Administration Software (RI-DAS) icons.  The Knowledge Base 
requires Adobe Acrobat Reader to be installed on your computer.   
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Getting Support 

Rotary International provides an on-line technical support forum for 
users of RI-DAS.  Our preferred method of communication is email 
which effectively eliminates the time zone problems associated with 
our support consultants and our customers being located all over the 
world. 

Many of you work with RI District Administration Software (RI-
DAS) at night at home. If a problem arises, the procedure would be to 
notify Rotary International of the problem by email (overnight) to 
distadmin.support@rotaryintl.org and generally expect a response 
by the next business day.   

Free support can be obtained from the RI-DAS Online Support Forum 
located at the web site www.https://riweb.rotaryintl.org . 
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What Type of Computer to Use 

RI District Administration Software (RI-DAS) is a Windows 
program and requires Windows 95/98, Windows 2000 or Windows 
NT.  The program will not work with Windows 3.11. 

RI District Administration Software (RI-DAS) requires a Pentium 
level PC (Personal Computer) or higher with a minimum of 32 MB of 
memory and 30 MB of disk space.  Network installations require each 
workstation to meet the minimum PC ratings but the fileserver does 
not need any special considerations. 

RI District Administration Software (RI-DAS) will only run on an 
Apple computer if that computer is capable of running Windows 32-
bit programs. 

Installing on a Single PC 

RI District Administration Software (RI-DAS) will install 
automatically from the installation CD or file downloaded from the 
RI-DAS web site in the same way as other Windows programs.   

Detailed step-by-step instructions for a stand-alone PC installation 
can be found in the installation section (see page 11). 
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Installing on a Network 

The procedure for installing on a network is different to installing on 
a stand-alone PC.  The installation will be carried out from each of the 
workstations that will use RI District Administration Software (RI-
DAS).  No installation will carry out at the fileserver itself. 

The primary consideration for network installation is the level of 
permissions the user, who is installing RI District Administration 
Software (RI-DAS), has to write to the network drives onto which 
you will install the shared RI District Administration Software (RI-
DAS) files and programs.  You will need to have sufficient 
permissions to create directories and write files on the selected 
network drive.  You will also need to be able to create icons on the 
workstation PC. 

Once installed each user needs to have sufficient permissions to write 
to their local hard drive and registry.  RI District Administration 
Software (RI-DAS) creates temporary files on the workstation 
computer during operation and uses the registry to save user 
preferences and settings. 

Permission settings can be complex and incorrect setup can provide 
unusual error messages such as “Can’t find file” or “A RI District 
Administration Software (RI-DAS) installation does not exist”.  
Please consult your network administrator to assist with installation. 

Detailed step-by-step instructions for network installation can be 
found in the installation section later in this chapter (see page 12). 
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After Installation 

A detailed Checklist can be printed from the first section of the 
Knowledge Base.  The Checklist provides a list of actions required 
for setting up and using RI District Administration Software (RI-
DAS) for the first time. 

It is important to complete the Checklist actions before using RI 
District Administration Software (RI-DAS).  Some setup 
requirements will affect the results of reports and club profile 
statistics. 

A sample district database, Rotary District Demo has been installed 
with your RI-District Administration Software (RI-DAS).  You may 
find it useful to examine how this sample district has been setup as 
well as to try out new functions first before attempting these in your 
live district data. 

 



Installation & Getting Started User’s Guide   11 

Installation & Upgrade 

Installation 

Stand-Alone PC (Not connected to a network) 

Insert the RI District Administration Software (RI-DAS) CD into 
your CD-ROM drive.  The Installation Menu should launch 
automatically.  

If the Installation Menu does not start, follow the steps below: 

1. Click on the Windows Start menu and select Run… 

2. In the Run dialog box, type the drive letter for the CD-ROM drive 
followed by a colon (for example D:) 

3. Click the Browse button.  In the Browse dialog box, click on the 
file named Setup.exe and click the Open button.   

4. In the Run dialog box, click OK.  The Installation Menu should 
appear. 

 

Click on the Install RI District Administration Software (RI-DAS) 
button to start the installation.   

Note: that the Knowledge Base User’s Guide will be installed as an 
on-line document.  You may need to install the Adobe Acrobat 
Reader to read this document.  Install this after installing RI District 
Administration Software (RI-DAS). 

 

Follow the on screen install instructions.  Select the New District 
Administration Installation option from the screen shown below, if 
you have never installed this software before.  Otherwise, select the 
Upgrade Existing Installation option if you have version 3000 of the 
software. Use the New District Administration Installation option 
if you have version 98.  
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During the installation you may be asked to re-start your computer 
before the install is complete.  Once Windows has restarted, if the RI 
District Administration Software (RI-DAS) installation does not 
automatically re-start, you may need to start the installation process 
again by re-inserting the RI District Administration Software (RI-
DAS) CD and clicking on the Install RI District Administration 
Software (RI-DAS) button. 

After installing, start RI District Administration Software (RI-DAS) 
from your Start menu.  The first time you run RI District 
Administration Software (RI-DAS) you will need to setup users, 
which is explained later in this chapter. 

Network Installation 

A network installation of RI District Administration Software (RI-
DAS) is always completed from the workstation PC.  There is no 
installation carried out at the fileserver. 
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From the first workstation PC start the installation process as 
described for the stand-alone PC above.  At the Installation Location 
screen (pictured above) select “New RI District Administration 
Software (RI-DAS) Installation” and use the Installation Directory 
button to select a network drive location. 

If you want to install RI District Administration Software (RI-DAS) 
on additional PC’s connected to the same network run the same 
installation process at each PC.   

At the Installation Location screen select the Add New User to 
Existing RI District Administration Software (RI-DAS) 
Installation option.  Use the Installation Directory button to point to 
the same network drive location that the previous RI District 
Administration Software (RI-DAS) PC’s used.  Point to the “Rotary 
International” directory.  The install program will always add the 
“\rd” directory after the “Rotary International” directory. 

 

If you have not pointed to the correct directory on the network drive, 
or if you have insufficient permissions to read the required directory 
an error message will be displayed. 
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Use the Installation Directory button to locate the correct directory or 
login as a user with administrator permissions. 

Note: Unless each network workstation installation points to the same 
RI District Administration Software (RI-DAS) file on the same 
network directory, the installations will not be sharing the same 
district database. 
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Uninstalling RI District Administration (RI-DAS) 

RI District Administration Software (RI-DAS) can have multiple 
districts installed.  Districts can be added and deleted using the 
District function from the File menu. 

To fully uninstall RI District Administration Software (RI-DAS) 
together with all installed districts use the Windows Add/Remove 
Programs function from the Control Panel. 

 

Re-Installing RI District Administration Software (RI-DAS) 

Re-installing RI District Administration Software (RI-DAS) will 
refresh the program files (which may have become damaged by a 
virus or some other program installation) and replace the Demo club 
database. 

To re-install and preserve your district registration and database use 
the installation instructions above and select the Add New User to 
Existing RI District Administration Software (RI-DAS) 
Installation option. 
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Adding or Upgrading Districts 

The District function, found in the File menu, allows you to add your 
district to the RI District Administration Software (RI-DAS) or select 
and upgrade an older version. 

 

Using the District menu you are able to create and register a new 
district database as well as open and close district databases, useful 
for looking at the demo database or when restoring a backup. 

Select the New District sub-menu to add your district or the Open 
District sub-menu to select the old database for upgrade.   

  

Open the “Old 
Version” of 
your district to 
begin the 
upgrade. 
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Type the name of your district into the District Name field.  The 
example shown above is Rotary District 121. 

Click on the Continue button.  You should move to the next screen in 
the registration process.   

Type in a suitable name for the directory to which RI District 
Administration Software (RI-DAS) will install the district files.  This 
directory will be automatically created under a directory named “RI 
District Administration Software (RI-DAS)” which is itself under the 
Programs Files directory. 

Click on the Continue button to create the district files or start the 
upgrade. 
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Starting RI District Administration Software (RI-DAS) the First 
Time 

The first time you login RI District Administration Software (RI-
DAS) the login User Name field will be empty.  Click on the button at 
the end of the field and choose the “Administrator” user name. 

 

Type the password “rotary” and click OK. 

The new or upgraded district is now registered and will open with 
your district name displayed in the middle of the screen. 
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Add Users 

The “Administrator” login cannot be used to operate RI District 
Administration Software (RI-DAS).  The menu and button bar buttons 
will be inactive.  The Administrator is only able to edit users, which 
should be your first job. 

To add the names of the people who will use RI District 
Administration Software (RI-DAS) in your district, open Define 
Users from the Setup User menu. 

 

The Toolbar contains buttons to add, save and delete users.  Click on 
the New button to add each user name.  Click on Save to add each 
name to the list. 

 

 

 

 

 

Toolbar 
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Type a password and select the security level. 

Standard  - Normal user 
Administrator - Normal plus able to edit and add users. 
Database Only - Can use the Secretary module only. 
Read Only  - Cannot make any changes to the database. 

 

If you do not wish to type your password each time you login to RI 
District Administration Software (RI-DAS), click the Remember 
Password checkbox. 

Close the Define Users screen and Close the district.  Then Open the 
district again.  This time you will be able to login with one of the new 
user names you have created and all the RI District Administration 
Software (RI-DAS) functions will be active. 

Administrator Login 

Each time you login in to RI District Administration Software (RI-
DAS) you will be presented with a list of User Names which includes 
those you have added as well as the Administrator login.   

The Administrator login should only be used if for some reason you 
have forgotten the password for the other login names or cannot login 
because of a problem with your database. 
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The password for Administrator is always “rotary” unless changed 
by you. 

After Upgrading 

RI District Administration Software (RI-DAS) has some minor 
differences to the earlier versions, for example the member name is 
now made up of 5 fields (Title, First Name, Middle Name, Last Name 
and Suffix), previously there were 3 fields (Title, First Name and Last 
Name).  The address fields now include a separate State field and a 
separate Gender field has been introduced. 

After upgrading you may wish to open the Contact Grid and check 
to see if the names and addresses of people need adjustment. 

You will need to check that the Gender field is correct for female 
members as Gender was set to “male” during upgrade. 

The “Married” checkbox has been removed from RI District 
Administration Software (RI-DAS).  If you still require this 
information on members set up a User Defined Field for marriage 
status. 

Tracked Positions are new to RI District Administration Software (RI-
DAS).  Check the Preferences menu and add Tracked positions. 

In the Treasurer Module you may need to check the names of your 
bank accounts in the Chart of Accounts.  Previously bank accounts 
could have a separate name to the account name, now there is only 
one name for bank accounts. 

Check the Chart of Accounts layout is correct.  It is now possible to 
select between different layout formats from the View menu in the 
Treasurer Module. 

Generally run reports and review information on contacts and 
accounts to ensure the upgrade was accurate before uninstalling your 
old database. 
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Getting Started Checklist 
 

Use this Checklist as your guide to setting up RI District 
Administration Software (RI-DAS).  The Checklist steps will point to 
the appropriate sections of the Knowledge Base where detailed 
instructions can be found.   

Knowledge Base 

 

The Knowledge Base is a complete User’s Guide and was installed 
when you installed RI District Administration Software (RI-DAS).  It 
can be opened from the Help menu or from the Knowledge Base icon 
found with the other RI District Administration Software (RI-DAS) 
icons.  The Knowledge Base requires Adobe Acrobat Reader to be 
installed on your computer.   

Be sure to email distadmin.support@rotaryintl.org if you have any 
questions.  We are here to help you understand this software and get 
the full benefits it can bring to your district. 

Secretary Module 
The Secretary Module is where you keep the people and clubs that 
make up your district.  Although named "Secretary Module" this 
program is not normally run by the district secretary. 

Any person who has the time can maintain the district’s computer 
records stored in your RI District Administration Software (RI-DAS) 
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database.  The results of keeping these records up-to-date can then be 
shared with other district officers. 

Copies of your RI District Administration Software (RI-DAS) 
database can be regularly sent to other district officers as an email 
attachment.  In this case you would send a backup file which would 
be restored by the receiver.  

Reports can be exported from RI District Administration Software 
(RI-DAS) in a number of formats and sent as an email attachment or 
even published on your district web site. 

Internet Option 

The best way to share your RI District Administration Software 
information is by using the RI District Administration Software ASP 
option.  This allows the program to be run via the Internet and any 
district officer (with the appropriate password) can login to the RI 
District Administration Software database from anywhere at any time.   

For example, any assistant district governor (ADG) can login to your 
district database from any computer with an Internet connection and 
complete a club visit memo.  At the same time, the district attendance 
officer can be entering the club Member & Attendance information 
received from clubs and the district treasurer can be entering financial 
transactions, each from their own separate locations.  Meanwhile the 
district governor can access this collaboratively produced district 
information at any time and make use of the club profiles or contacts 
data to manage the district.  Even the incoming district governor can 
share these files from any location and start creating the district 
structure for the next year taking advantage of the valuable 
information that already exists.  
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Setup Steps for RI District Administration Software (RI-DAS) 

Once you have installed RI District Administration Software (RI-
DAS), completed the registration of your district name and created 
users, all explained in the Installation section of the Getting Started 
User’s Guide, you should follow the following steps to set your 
district up: 

Upgrade from version 5.0 or 6.0 

If you have a version 5.0 or 6.0 database to upgrade then the upgrade 
should be done now as the first step to setting up RI District 
Administration Software (RI-DAS).  Upgrade instructions are 
provided in the Installation section of the Getting Started User’s 
Guide.  After upgrading complete the Checklist steps which follow: 

Step 1 – Setup District 

 

In District Setup, found under the View menu, the first tab District 
Details enter your district mailing address.  Refer Chapter 2 Setup 
District & Preferences. 

Step 2 – Setup Positions & Committees 

In District Setup, found under the View menu, the second tab 
Descriptions add district positions, district committees, club 
positions, affiliate positions and other positions.  Also connect 
positions to committees where appropriate.  Refer Chapter 2 Setup 
District & Preferences. 
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Step 3 – Create Other Club Types 

In District Setup, found under the View menu, the second tab 
Descriptions add Other Club Types in preparation to adding Other 
Clubs. Refer Chapter 2 Setup District & Preferences. 

Step 4 – Create Other Clubs 

 

In Other Clubs found under the View menu create the Other Clubs. 

Other Clubs are the Rotaract, Inner Wheel and other similar 
organizations that can be connected to people (Contacts).  This step 
can be skipped as Other Clubs can be added directly and as needed, 
while adding a contact.  Refer Chapter 2 Setup District & 
Preferences. 

Step 5 – Import Data 

If you have no data to import go directly to Step 6. 

Your district information, people and Rotary clubs, can be imported 
into RI District Administration Software (RI-DAS) from other 
software (including an extract of your district data available from the 
RI database, check with RI).   

Your district information can also be created by importing each 
database from any Rotary club in your district that uses RI Club 
Administration Software (RI-CAS). 

It is also possible to firstly import from other software then at a later 
time import the same club and member information from the club’s 
RI Club Administration Software (RI-CAS) database without creating 
duplicate records.  RI District Administration Software (RI-DAS) will 
attempt to match a member from the two different sources by 
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comparing the Last Name, Date of Birth and Date Joined fields for 
each person. 

Once you have successfully used a club’s RI Club Administration 
Software (RI-CAS) database to update or create your district 
information a special reference is created which links a member in the 
club’s database and the same person in the RI District Administration 
Software (RI-DAS) records. 

When importing data from a non-RI District Administration Software 
(RI-DAS) source the import file should include the Rotary club name 
as part of each record.  RI District Administration Software (RI-DAS) 
will attempt to match the imported Rotary club name to one that 
already exists in RI District Administration Software (RI-DAS).  If 
the import process does not find the Rotary club in RI District 
Administration Software (RI-DAS) it will create a new club.  This 
may be a rapid way to add clubs to your RI District Administration 
Software (RI-DAS) records. 

Import from a non-RI District Administration Software (RI-DAS) 
source is discussed in Chapter 28 Import Export.  The Club Update 
Import from a club that uses RI Club Administration Software (RI-
CAS) is found in Chapter 27 Club Update Import. 

Step 6 – Setup Rotary Clubs 
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Click on the Rotary Clubs button on the button bar to open the Club 
Grid and add the Rotary clubs for your district.  Adding Rotary clubs 
is discussed in Chapter 3 Setup Clubs & Contacts. 

Step 7 – Setup Zones/Areas 

 

If your district is split into zones or areas these can be added using the 
Zones/Areas function found under the View menu.  Refer to Chapter 
2 Setup District & Preferences. 

Step 8 – Add Contact Records 

 

Now that all the clubs and other components have been setup in RI 
District Administration Software (RI-DAS) you can finally add the 
people. 

If you have imported contact records or are adding them manually it 
is recommended that you read the section on how RI District 
Administration Software (RI-DAS) works using the Member Type 
field, connections to clubs and assignments of positions, which found 
in Chapter 3 Setup Clubs & Contacts. 
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Step 9 – Edit Name Format Preferences 

 

Name Formats are where you establish how RI District 
Administration Software (RI-DAS) will display people’s names for 
the different situations where names are used.  Refer Chapter 2 Setup 
District & Preferences. 

Step 11 – Edit Contact Records 

The Contacts Grid discussed in Chapter 7 Contacts Database 
describes how you can create views and edit contact information 
directly in the grid.  This is more important if you have imported your 
contact records. 

Step 12 – Opening Club Statistics 

 

 

 



30 Installation & Getting Started User’s Guide 

Getting Started Checklist 

Club statistics found in each club’s Club Profile are compared to the 
Start numbers.  These are normally transferred from the June close 
numbers from the previous year, but if this is the first time you are 
using RI District Administration Software (RI-DAS) you may need to 
add these opening statistics. 

Adding club statistics is discussed in Chapter 8 Club Profiles. 
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Treasurer Module 
The Treasurer Module is designed to manage the income and 
expenses for a district governor or a district committee.  This is a full 
accounting system that is normally run “stand-alone” on a separate 
computer to the Secretary Module.  Very little of the information 
contained in the Secretary Module is needed in the Treasurer Module. 

Install RI District Administration Software (RI-DAS) on the computer 
used by the treasurer and follow these setup steps: 

Step 1 - Starting date 

RI District Administration Software (RI-DAS) will look at your 
computer’s date and set the starting date for your accounts as July 1st 
of the current Rotary year (July 1st to June 30th).  If you would like to 
load balances and transactions into the previous year, you must 
change your computer’s date to June 30 or before of the previous 
Rotary year before creating your district database. 

If you have already created your district database and wish to change 
to an earlier start date, you must delete the district and create it again 
with the computer date set as outlined above. 

Step 3 - Accounting format 

Accounting Format, found under the View menu, defines the layout 
of your Chart of Accounts.  There are two options one with Income 
accounts first and one with Asset accounts first.  Select the option you 
wish to use.  This selection can be changed at any time. 

Step 4 - Setup Chart of Accounts 

Add and change the accounts you wish to use for your district’s 
accounting system.  New accounts can be added at any time however 
it is a good idea to decide on an accounting structure as early as 
possible.  Refer to Chapter 24 Chart of Accounts. 
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Step 5 - Setup additional Entities 

If your district runs a separate trust or foundation then you can setup a 
new entity and Chart of Accounts for this.  Refer to Chapter 4 Setup 
Accounting. 

Step 6 - Setup taxes 

If your districts needs to account for either sales tax or GST/VAT 
style of tax use Tax Code Setup found under the View menu. 

Step 7 - Setup projects 

Projects is how RI District Administration Software (RI-DAS) takes 
care of fundraising activities and charitable donations.  Create a 
separate project for each activity.  Refer to Chapter 20 District 
Projects. 

Step 8 – Setup Clubs & Other Clubs 

RI District Administration Software (RI-DAS) uses the Rotary clubs 
and Other Clubs setup in the Rotary Club Grid and Other Club 
Setup for billing and accounts receivable. 

If the district treasurer operates from a separate computer, the Rotary 
clubs and Other Clubs can be obtained from a separate Secretary 
Module database by restoring a backup file, however it is probably 
just as quick to re-enter the clubs in the Treasurer Module copy. 

Step 8 - Load opening balances 

Opening balances are the closing Balance Sheet balances from your 
last set of (non RI District Administration Software (RI-DAS)) 
accounts.  Read the Load Opening Balances chapter in the 
Knowledge Base for detailed instructions.  Loading opening balances 
requires some double-entry accounting skills and we recommend you 
obtain assistance to ensure this important setup phase is correct. 

 



Installation & Getting Started User’s Guide   33 

Getting Started Checklist 
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Overview 
 

RI District Administration Software (RI-DAS) is a product designed 
so that a computer beginner can manage a district with ease and style.  
Getting started is uncomplicated and the way it works is easy to 
understand.   

How does RI District Administration Software (RI-DAS) work? 

The information you need is held in three lists – Contacts (people), 
Clubs (Rotary Clubs) and Other Clubs (Rotaract, Inner Wheel, etc.).  
The lists fit together and form your district.  Using the lists you can 
establish the jobs people do (positions), such as district chairs and 
committees, club presidents or exchange students, and you can collect 
information about your clubs – statistics on member numbers and 
attendance, projects, events and correspondence. 

Above all you can easily communicate with people using email, fax 
or letter and coordinate your district activities. 
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Connections Between the Lists 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The information in the lists can be imported from another program, 
typed in manually or gathered electronically from the Rotary clubs in 
your district. 

Contacts 

The Contacts List contains three groups of people: 

1. Rotary club members (listed by Member Type – Active, 
Senior Active etc.) 

Contacts List 

Blacktown Rotary 
Mr. Peter Smith 
President 

East Brunswick Rotary 
Miss. Hillary Jones 
Exchange Student 

Greenacre Rotary 
Mrs. Janice Klinger 
President 

Kyle Bay Inner Wheel 
Mrs. Karen Smith 
President 

Rotary Club List 
Blacktown 

Crystal Springs 

Devonport River 

East Brunswick 

Greenacre

Other Club List 
Blacktown Rotaract 

Blacktown Inner Wheel 

East Brunswick Rotaract 

Greenacre Probus 

Kyle Bay InnerWheel 
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2. People “Sponsored by” a Rotary club e.g. exchange student, 
ambassadorial scholar 

3. People who are “Non Members” of a Rotary club e.g. Inner 
Wheel president. 

People are listed in a “spreadsheet” like grid which is able to be 
changed by you to list any group and any information you need to 
use. 

 

The grid above includes all club presidents and shows their name, the 
club they belong to, their partner’s first name and contact phone 
numbers.  The information shown (name, phone etc.) is called a 
“View” and can be changed by you and saved.   

The group included here is the club presidents for the current year.  
The group is selected by a “Select Filter” and these can also be 
changed and saved.  For example you could create a Select Filter to 
show all exchange students or all committee chairs or everyone on a 
particular committee.  Each time you the select a new group, you see 
the information from the “View”, their names, partner’s names, phone 
numbers etc.  The number of groups you can create is unlimited. 
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Behind each row in the grid are the details stored on each person.  To 
add a new person or change the details, just pop-up the Contact 
Details card. 

Contact Details 

Information on each person is clearly laid out.  The connection 
between a Contact and a Rotary Club is noted as well as the positions 
they hold.  If this person was a “Non Member” then the connection 
would be to an Other Club or there may be no connection at all. 

 

Notice the circled “Send Message By” information.  Here you can set 
the preference this person has for receiving messages from district.  
Later you will see how you can email, fax or mail messages directly 
from RI District Administration Software (RI-DAS) using each 
person’s preferred method. 

 

 

This is where a 
person is connected 
to a club. 

This is where the 
positions held are 
added. 
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Adding positions to a Contact is a snap.  Click on the Add button and 
a list of the positions you have created is displayed.  Select one and 
you are done. 
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Rotary Clubs 

 

The Rotary Clubs are also listed in a “spreadsheet” like grid which 
can be changed by you.  The clubs listed can be grouped and selected 
in the same way as the contacts can and messages sent to the officers 
of selected clubs in seconds. 

 
You can setup checklists which are useful if you need to note when a 
club has done something such as send a report or respond to a request.  
The checklists can be used to send a message to those clubs who have 
not sent the report or responded.  It is very quick and efficient. 

You can create “Club Categories” which can include any useful club 
characteristic you wish to note such as the club status - growing, 
shrinking in danger, or a fact like – “has exchange student”.  You can 
then sort and select clubs using these categories to produce very 
useful management information. 
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The clubs displayed on the grid can be grouped by the information 
displayed so that you can quickly group or sort clubs by the days or 
times they meet, zones or areas, number of members or even the 
average age of the members. 

Behind each row of the club grid is a comprehensive Club Profile 
which contains a wealth of information and facts on each club. 

Club Profile 

The key to effective club management is the ability to collect 
information on each club.  The Club Profile lists all the relevant 
information you will need to know on a club. 

 

Club Details are the basic details on each club such as the club’s 
name, contact address information, meeting place and the particular 
club categories you have assigned. 
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Club Officers lists all the people with relevant club officer positions 
for the Rotary year you have selected.  RI District Administration 
Software (RI-DAS) “knows” who the clubs officers are and these lists 
are filed “automatically”.   

 



42 Installation & Getting Started User’s Guide 

Overview 

 

Statistics lists the attendance and membership information and 
displays trends and comparison to the club’s goals.  This information 
can be gathered electronically each month from your clubs. 
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Associations are the people and Other Clubs who have an association 
with this club.  This group is created “automatically” by RI District 
Administration Software (RI-DAS) identifying the connections 
between the lists of people and clubs in your district information. 

The other sections of RI District Administration Software (RI-DAS) 
Profile list Club Events, Fundraising activities, Club Visit memos and 
General Notes. 

Other Clubs 

Besides Rotary clubs your district will also need to keep track of other 
clubs, often associated to the Rotary clubs themselves. 

The Other Club setup creates these clubs and allows a connection to 
be made from the Other Club to a particular Rotary club in the same 
way as the Contact records are connected to clubs as mentioned 
earlier.  
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Details of Other Club mailing address and numbers of members can 
be used in the communications and Treasurer sections of RI District 
Administration Software (RI-DAS). 

Other Club “types” can be established by you and can include 
organizations such as companies, charities or any group you wish to 
track in your district.  As the Other Clubs can be billed in the 
Treasurer module, this is an excellent place to setup district 
conference sponsors or other interested parties. 

People in your Contacts lists can be connected to Other Clubs in the 
same way as they would be to a Rotary club.  You are now able to 
extend your district information to include a wide range of 
organizations and the people associated with these. 
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District Keywords 

An exciting concept for your district would be the ability to create a 
resource database to allow a more effective coordination of projects 
and activities. 

District Keywords are created by your district and “published” to 
your Rotary clubs via email or via the Internet.  The clubs can apply 
the key words to their members and the assignments are automatically 
included in the monthly club electronic reporting to district. 

 

In the district Contacts list you now have the ability to select and 
communicate with people based on their District Keyword 
assignments.  

Imagine you had a project that called for the use of a small truck for a 
weekend.  Using the key word assignments you could pull up the list 
of people who had offered the use of a small truck and send them all 
an email requesting availability.  
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Properly coordinated the district keyword functions can create 
enormous value for your district. 

Communications 

Select a group of Contacts or clubs and send them a message directly 
from RI District Administration Software (RI-DAS).  For example, 
you want to send a reminder to all your clubs who have not sent their 
monthly report to district.  Most of your club officers prefer email but 
some still want a fax and one or two prefer to receive a letter. 

From the Club Grid select the clubs without a check mark in Report 
Checklist you created.  Then click on the Email button.  The RI 
District Administration Software (RI-DAS) message screen will pop 
up and contain the names of all the club officers who have a preferred 
“message by” of email.  Write your message and click Send.  RI 
District Administration Software (RI-DAS) works with your 
computer’s email profile and sends the message to each person in the 
list. 
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With the same group still selected from the Club Grid, click on the 
Fax button.  Only those club officers who want to receive a fax will 
be included in the list.  You can re-use the text from the message you 
just sent by email by clicking the Message button.  With the message 
already written (using the email text) just click the Send button.  RI 
District Administration Software (RI-DAS) will use the MAPI 
compliant fax software available to your computer to send a fax to 
each of the people in the list. 

Finally, still with the same group selected, click the Letter button.  
Only those people who prefer a letter will be included in this list.  Re-
use the text from the email message then click the Print button.  Fully 
formed letters properly merged with the club officer’s and addresses 
will be printed to your printer.  

The same method of sending messages can be used to distribute 
monthly newsletters, invitations to functions, notifications of 
meetings etc. and can include any group, club officers, district 
committee chairs, exchange students or anyone you have setup. 



48 Installation & Getting Started User’s Guide 

Overview 

Reporting 

The information contained in your district lists is only as good as your 
ability to create useful management reports and rosters. 

The reports available in RI District Administration Software (RI-
DAS) are extensive and useful. 

 

From mailing labels to roster lists the RI District Administration 
Software (RI-DAS) reports cover everything you should need to 
manage your district. 

For example, the Positions reports allow all your district and club 
officer positions, for any Rotary year, to be accumulated and printed, 
exported or published on your web site.  This is in effect an instant 
district roster and is constantly kept up-to-date and can be reprinted 
and re-published as often as you need.   

The Statistics reports show the trends of attendance, membership and 
fundraising efforts for your district and for each club.   



Installation & Getting Started User’s Guide   49 

Overview 

The Contact reports provide useful telephone lists, email lists or 
event attendance lists for any group in your district. 

The District reports list your district structure broken down into 
zones or areas, the zone/area officers and the clubs they are 
responsible for.  There are also reports to list past district officers, 
other clubs, import dates to manage electronic reporting and mailing 
labels for your clubs. 

All this information can be printed or can be sent directly to a web 
site.  You will be surprised at the power and simplicity of the RI 
District Administration Software (RI-DAS) program. 

 

 



50 Installation & Getting Started User’s Guide 

Overview 

Treasurer 
In addition to the club and people management, RI District 
Administration Software (RI-DAS) has a complete accounting system 
for district. 

The Treasurer module can be run on a separate computer and is 
designed to manage a district governor’s expenses.  The module can 
also be run independently by any district committee that requires 
accounting control at no extra cost. 

The Treasurer module includes: 

¾ Invoicing and receivables management based around the 
Rotary clubs and Other clubs in the district.  District dues 
can be calculated on the number of members in a club as 
well as incremental dues for new members added during 
the year. 

¾ Cashbook for multi bank accounts to manage the cash 
received and expenses for the district. 

¾ General Ledger and chart of accounts to create useful 
district level financial reports, budgets and complete 
control over charitable activities. 

RI District Administration Software (RI-DAS) has been created for 
you. Please enjoy. 
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